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MAKE THE MOST OF YOUR BUSINESS INTERNET HIGH SPEED ENTERPRISE SERVICE!

Below are all the steps you will go through to get connected with the Business Internet High Speed Enter-
prise service. Remember to take advantage of all of the additional features that the service offers!

Service technician will come install your serice

Receive a
Order our Welcome
service! Letter in the
mail

Receive your
kit in the Mail

Connecting and
Disconneding from
the Intemet

Install the
software

Install the
hadware

page 18

page 14

SURF THE
INTERNET at
HIGH SPEED!

Use the Global
Roaming Dialer to
connect to the
Internet when you
are away from work!

page 28

Please keep note that your Business Internet High Speed Enterprise service will be activated
by midnight on the due date given to you at the time of purchase.
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MINIMUM HARDWARE REQUIREMENTS

For the Business Internet High Speed Enterprise software to work reliably and efficiently, your computer
must meet or exceed the minimum requirements specified in the table below:

Windows

Processor 133 MHz Pentium or equivalent processor

System Windows XP*/Me/98/2000**/NT 4.0**

Memory 64 MB RAM

Hard drive 80 MB free

Display 256 colours with 800x600 resolution

Network Ethernet card installed and functioning or available
USB port

CD-ROM drive Required

* If you have Windows XP, the minimum requirements are greater than those listed here. Please see the
following:

Processor: 300 MHz single CPU for Home edition, or single or dual for Professional edition
Memory: 128 MB RAM

** If you have Windows 2000 or NT, you must have the latest service pack installed.
You may need your Windows CD to perform some of the software configurations in this guide.

QUICK START PROCEDURES

Check the contents of your Starter Kit

To see a list of the equipment you should have, consult Check the contents of your Starter Kit on page 6.

Install the software

1. Turn on your computer. Exit all programs and disable any virus protection software.
2. Insert the Business Internet CD into your CD ROM drive.

3. Follow the instructions to install the software.

Install the hardware
4. Connect the modem and install the phone filters on every phone with the same telephone number as
your Business Internet High Speed Enterprise service. Do not install filters on your modem.

5. Check your setup. Please refer to Checking your setup on page 11 for an illustration of the proper
hardware setup.

Connecting and Disconnecting from the Internet
6. Double-click the Access Manager icon on the desktop.

7. Double-click the Business Internet High Speed icon in the Profiles window, then click Connect in the
Access Manager window to connect to the Business Internet High Speed Enterprise service.
If you have Windows XP, double-click the Business Internet High Speed Enterprise icon on the
Desktop, then click Connect. Then click the Internet Explorer icon.
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To disconnect, click the File menu in Internet Explorer, then click Exit. To disconnect from the Internet,
right-click the Access Manager icon at the bottom right of your screen, then click Disconnect.

If you have Windows XP, double-click the connection icon in the lower right hand corner of the screen,
then click Disconnect.

Make the most of your Business Internet High Speed Enterprise service! 3



BEGINNING THE INSTALLATION

BEFORE YOU BEGIN

For the Business Internet High Speed Enterprise software to work reliably and efficiently, your
computer must meet or exceed the minimum hardware requirements specified on page 2.

Before you begin, have the following information ready in order to install the software. You can find this infor-
mation on the first page of this guide.

*  your Business Internet High Speed Enterprise
* username

» password

access over a Local Area Network (LAN). Configuring the Business Internet High Speed Enter-

1 The Business Internet High Speed Enterprise software is not designed to support Internet
prise software may cause conflicts with your existing network service.

STARTING THE INSTALLATION

1. Exitany applications or programs, and disable any virus protection software before installing the soft-
ware. For instructions, see the manual that came with your virus protection software.

2. Insert the Business Internet High Speed Enterprise CD into your CD-ROM drive. Wait a few seconds. The
installation program usually starts automatically. If it doesn’t, double-click the My Computer icon on
your desktop, and then double-click the Bell icon.

3. You will be asked to agree to the Business Internet High Speed Enterprise Terms and Conditions. Click

Accept if you agree.

4 Beginning the Installation



4. Tests are conducted to ensure that your
computer meets the minimum requirements
needed to install the software.

When a hardware or software component meets

or exceeds the recommended requirements, a System Check
green check mark is displayed to the right of the cpu INeI(R) Pertiu(R) 4 CPU 2.53GHz 25 Gz v
component. Memory 2418 v
When a hardware or software component does i e , y
perating System Microsoft Windows 2000 Service Pack 3 v
nOt meet the minimum reqUirementS’ a red X iS Hetwork Card Intel(R) PRO/M 000 MT Network Connection V4
displayed to the right of the component, and the uss Present )
software cannot be installed. Display 1152 X 864 (32 bits) )

When a hardware or software component meets
or exceeds the minimum requirements but does Congratultionst Your systerm meets the recommended @
not meet the recommended requirements, a requirements. e
yellow exclamation mark is displayed to the right

of the component. You can improve the perfor-
mance of the software by upgrading these
components to the recommended require-
ments.

You can click the Details button for more information on each of the tests performed.
If you see a message that your machine meets the requirement, click Next.

<Back

Cancel |

5. Click Next if you have an Ethernet port on your
computer.
If you do not have an Ethernet port on your
computer, click USB. If you choose USB, you will
need to restart your computer after installing the
USB software, and you may need to provide your
original Windows CD.

6. A screen appears showing how your wires
should be connected. You can also see this
diagram under Checking your setup on page 11.

Select Modem Cable

Click "Hext" if you have an Ethernet port installed in your computer.

Ethernet cable

Ethernet modem jack

UsB If you do not have an Ethernet port installed in your computer, click
"USB". If you require more information about the differences
between Ethernet and USB connection methods, click "Help". E]

Help

<Back

Cancel |

k( Please proceed to Installing the Hardware on page 6. >
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INSTALLING THE HARDWARE

CHECK THE CONTENTS OF YOUR STARTER KIT

Your Business Internet High Speed Enterprise Starter kit should contain the following:

1. DSL high speed modem box, if you ordered one from Bell, should contain:
a. DSL high speed modem (your modem may look different, depending on the brand)

* Note: BC and Alberta customers’ modems will be shipped separately from their Internet High Speed
Starter kit.

b. DC power supply with cable
c. Telephone cable with standard telephone plugs, called RJ-11
d. Ethernet cable with plugs slightly larger than the phone cable plugs, called RJ-45

e. USB cable only included with the Speedstream 5200 modem

Desktop filters. (Additional filters (including wall filters) can be ordered online at www.proformagms.com/bell)
1 Telephone line splitter

Installation Guide (what you are currently reading)

Software Installation CD

nhWwN
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Leave your computer on while you perform the following steps.

CONNECTING A FILTER TO EVERY PHONE

You must now install afilter on every phone with the same telephone number as your Business
Internet High Speed Enterprise service.

k If you require additional filters or wall filters for wall mounted phones, you can order them
online at http://www.proformagms.com/bell

Repeat this process for every desktop phone on the same line as your Business Internet High Speed
Enterprise service:

1. Unplug the telephone cable from the wall jack, and plug a
desktop filter into the wall jack.

2. Plug the telephone cable you unplugged from the wall jack
into the filter.

-l

IF A WALL JACK IS TO BE SHARED BY MODEM AND PHONE (OPTIONAL)

1. First plug the phone cable from the modem into the splitter.

2. Then plug the filter (from the phone) into the splitter.

From phone

k If you are using the Ethernet cable, proceed to If you are Using the Ethernet cable on page 8.

If you are using the USB cable, proceed to If you are using the USB cable on page 9.
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IF YOU ARE USING THE ETHERNET CABLE

Please follow these instructions if you are using the Ethernet cable. If you are using the USB cable, please
proceed to If you are using the USB cable on the next page.

1. Make sure that the Efficient Networks SpeedStream 5200
modem has adequate ventilation. Place the modem on an
even, hard surface at least one foot away from your moni- ;
tor, computer case, or other electronic devices including = =
speakers. The modem will need to be within 6 feet (or 2
meters) of your phone jack.

Your modem should be supplied with an Ethernet cable, Phone cable | Ethernet cable
and a phone cable. The Ethernet cable has slightly larger

plugs.

2. Connect one of end of the Ethernet cable into the largest p— ’
jack on the back of your desktop computer or into the
largest jack on the back of your laptop computer, or to the ’/;!f.v.
media coupler attached to your laptop. - ?‘!—7‘,

L7 = -‘Q\ A/

3. Connect the other end of the Ethernet cable into the largest jack on
the back of your modem.

Depending on your modem brand, the jack will be labeled \
Ethernet, 10Base T, ENET, or this symbol (] . N

4. Connect one end of the phone cable to your telephone wall jack.

5. Connect the other end of the phone cable to the back of your
modem.

Depending on your modem brand, the jack will be labeled ADSL,
DSL, Line, or this symbol D .

6. Connect your modem’s power supply to the modem, and then plug the other end into a power bar. A
surge protected power bar is recommended.

i(Proceed to Checking your setup on page 11. )

8 Installing the Hardware



IF YOU ARE USING THE USB CABLE

1. The USB software installation program will start.
2. Follow the instructions in the SpeedStream program to install the USB software.

k ( If you have Windows 98, you will need your Windows CD to complete the installation. )

3. When you see the window telling you to connect the modem, connect the Efficient Networks Speed-
Stream 5200 modem as described in Connecting the USB modem on the next page.

SpeedStream

®
3p eedStream Install line filters and connect the modem.

DSL Consult your Quick-Start Guide for details.
Software installation will continue when the
modem is properly connected.

Updating the Registry

-ance

OEfﬁcient
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CONNECTING THE USB MODEM

1.

6.

Make sure that the Efficient Networks SpeedStream 5200 modem has adequate ventilation. Place the
modem on a hard, level surface at least one foot away from your monitor, computer case, or other elec-
tronic devices including speakers. The modem will need to be within 6 feet (or 2 meters) of your phone
jack.

Connect the power supply to the modem, and then plug the other end into a surge protected power

bar.
Connect one end of the phone cable to your telephone wall jack.

Connect the other end of the phone cable to the DSL port on the
Efficient Networks SpeedStream 5200 modem.

Connect the USB cable to the USB port on the back of your desktop
computer, or on the side of your laptop computer. The USB port

will be labeled with the symbol e .

Connect the other end of the USB cable to the USB port on your
Efficient Networks SpeedStream 5200 modem.

your setup on page 11.

k (You are now asked to restart your computer. Click Finished to restart and proceed to Checkin_c?
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CHECKING YOUR SETUP
If you have the Alcatel modem, the overall wiring should look like this:

RJ11 PHONE CABLE

FILTER

SPLITTER PHONE JACK

RJ45 ETHERNET CABLE

If you have the SpeedStream modem, the setup should look like this if you are using the Ethernet cable:

FILTER SPLITTER PHONE JACK
RJ11 PHONE CABLE v

DC POWER SUPPLY

RJ45 ETHERNET CABLE

Installing the Hardware 11



CHECKING YOUR SETUP (CONTINUED)

Your setup should look like this if you are using the USB cable with the SpeedStream modem:

FILTER SPLITTER

V

PHONE JACK

Rehg

RJ11 PHONE CABLE

DC POWER SUPPLY

USB CABLE

All other rooms
with phones that
have the same
number as your
internet service:

| FILTER PHONE JACK
RJ11 PHONE CABLE
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CHECKING YOUR SETUP (CONTINUED)

Make sure your modem and computer are turned on.

2. If you have the SpeedStream modem with an Ethernet
cable, wait until the pwr, dsl, and enet lights are on. If
you are using the USB cable, wait until the pwr, dsl and
usb lights are on.

If you have an Alcatel modem, wait until there are two
solid green lights on the modem.

If the lights are not on, turn the modem and computer off. Make sure that all the cables are connected
securely, then turn the computer and modem back on. If this does not work, contact the Help Desk. The
appropriate number is on the first page of this guide.

k (Please proceed to Configuring the Software on the next page)

Installing the Hardware 13



CONFIGURING THE SOFTWARE

Before continuing, you should have completed the steps in Beginning the Installation on page 4 and Installing
the Hardware on page 6.

IF YOU HAVE WINDOWS XP

1. Click Next to install the Business Internet High Speed Enterprise software.

N

After the installation, your computer restarts. Do not remove the CD-ROM from your computer.

w

On the Finished screen that appears,
click Finish.

Finished ..
The wizard is ready to create your connection. ?|/|

Type a name you want for this connection:
Business Internet High Speed Enterprise]
Click Finish to save it in the Network Connections folder.

To edit this connection later, select it, click the File menu,
and then click Properties.

[ < Back " Finish ][ Cancel ]

4. The Connect Business Internet High Speed Enterprise
window appears. Type your Business Internet High Speed
Enterprise username (followed by the @ symbol and your
domain name) and password, then click Connect.

Connect Business Internet High Speed

User name: username{@domain.com

Password: eccccsee

Save this user name and password for the following users:

(® Me only
(O Anyone who uses this computer

[ Connect ][ Cancel ][ Properties ]l Help
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5. Click the Extras button to install the iPass Global Roaming dialer and the VPN Remote Access Client. Refer
to Setting up your optional Business Internet Dial Enterprise Hours on page 28 for instructions on how to
use iPass Global Roaming. Refer to Installing the VPN Remote Access Client (optional) below for instruc-
tions on how to use the VPN software.

6. After you have installed the extra software, click Finish to end the software installation. Please proceed

to Connecting to and Disconnecting from the Internet with Windows XP on page 15 below.

INSTALLING THE VPN REMOTE ACCESS CLIENT (OPTIONAL)

1. If you wish to install the VPN Remote Access Client software, exit all applications or programs, make
sure you are not connected to the internet, and disable any virus protection software before installing
the software.

2. Inthe Extras screen, click IP VPN Remote Access Service.

3. Follow theinstructions on the screen, clicking Next or Yes at each step. A progress bar will show the VPN
Remote Access Client software being installed on your computer. You may be asked for your original
Windows CD-ROM during this process.

4. On the last screen, click Finish. Your computer will restart.

5. Click Close and then Finish to end the software installation.

CONNECTING TO AND DISCONNECTING FROM THE INTERNET WITH WINDOWS XP

1. To connect to the Internet, double-click the Business Internet High Speed Enterprise icon on the
Desktop, then click Connect. Then click the Internet Explorer icon.
2. When you are ready to disconnect from the Business Internet High Speed Enterprise service, double-click

the Business Internet High Speed Enterprise icon on the Desktop, then click Disconnect.

The installation and configuration of your Business Internet High Speed Enterprise software is
% now complete!
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IF YOU DO NOT HAVE WINDOWS XP

1. Click Next to install the Business Internet High Speed Enterprise software.

2. After theinstallation, your computer restarts. If you have Windows 98 or Me, your computer will restart
twice.

3. Click the Extras button to install the iPass Global Roaming dialer and the VPN Remote Access Client. Refer
to Setting up your optional Business Internet Dial Enterprise Hours on page 28 for instructions on how to
use iPass Global Roaming. Refer to Installing the VPN Remote Access Client (optional) below for instruc-
tions on how to use the VPN software.

4. If you decide not to install the extra software, click Finish to end the software installation. Please proceed

to Configuring the Access Manager on page 17.

INSTALLING THE VPN REMOTE ACCESS CLIENT (OPTIONAL)

1. If you wish to install the VPN Remote Access Client software, exit all applications or programs, make
sure you are not connected to the internet, and disable any virus protection software before installing
the software.

2. In the Extras screen, click IP VPN Remote Access Service.

3. Follow the instructions on the screen, clicking Next or Yes at each step. A progress bar will show the VPN
Remote Access Client software being installed on your computer. You may be asked for your original
Windows CD-ROM during this process.

4. On the last screen, click Finish. Your computer will restart.

5. Click Close and then Finish to end the software installation. Please proceed to Configuring the Access

Manager on page 17.
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CONFIGURING THE ACCESS MANAGER

When your computer has restarted, you will see a message informing you that it is setting up your new
software. It should only take a few minutes to configure the software.

1. Double-click the Access Manager icon on the desktop.
Double-click the Create New Profile icon in the Access Manager window.
3. Follow the instructions to create a new profile, and input the following info when prompted:

* For the name of the profile: type Business Internet High Speed Enterprise.

* In the User Name box: type your username followed by the @ symbol followed by your domain
name: username@domain (for example: smith@bellnexxia.net).

* In the Password box: type your password. The password field is UPPER CASE/lower case sensitive.

* You can find this information on the first page of this guide.

4. You may need to select the device you are bevices o i
connecting with: either Ethernet or USB.
5. After you have created your profile, you will see a BRI &Y o orvai, e deves hetulbe sed o sablsh

Business Internet High Speed icon in the Access
Manager window. Double-click this icon, then
click Connect. Double-click the Internet
Explorer icon on the Desktop.

) |3I:om EtherLink XL 10/100 PCI TX NIC [3CSDSB-T><j
[3Com EtherLink XL 10/100 PCLTX NIC (3C305B-TX

Speedstream Ethernet USE Adapter

now complete! For help on using the software, refer to Connecting and disconnecting from the

k The installation and configuration of your Business Internet High Speed Enterprise software is
Internet on page 18.
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CONNECTING AND DISCONNECTING FROM THE INTERNET

You mustinstall the Access Manager to connect and disconnect from the Business Internet High
Speed Enterprise service. To install the Access Manager follow the instructions in Beginning the

k Installation on page 4.

If you have Windows XP, you will not use the Access Manager. Please refer to Connecting
automatically to the Business Internet High Speed Enterprise service on page 19.

CONNECTING TO THE INTERNET

-
Double-click the Access Manager icon ﬂ on the desktop. Double-click the Business Internet High

Speed Enterprise icon in the Profiles window, then click Connect in the Access Manager window to
connect to the Business Internet High Speed Enterprise service.

OR

You can also start the Access Manager by clicking Start, then Programs, then Business Internet High
Speed, then clicking Access Manager. Double-click the Business Internet High Speed Enterprise icon
in the Profiles window, then click Connect in the Access Manager window.

After the Access Manager connects, it starts Internet Explorer.

DISCONNECTING FROM THE INTERNET

In Internet Explorer, click the File menu, then click Exit. To disconnect from the Internet, right-click the
Access Manager icon at the bottom right of your screen, then click Disconnect. You can also double-

click the Access Manager icon on the Desktop, double-click the Business Internet High Speed Enter-
prise icon, then click Disconnect. Click Exit to close the Access Manager.

CONFIGURING THE ACCESS MANAGER TO DISCONNECT AFTER A SET AMOUNT OF TIME

This is helpful from a security perspective if you happen to forget you are connected or do not want
anyone else to use your account.

1. Double-click the Access Manager icon on the Desktop, then double-click the Business Internet High
Speed Enterprise icon. Right-click the Access Manager icon at the bottom right of your screen (in the
system tray), then click Profile Properties.

Click the TCP tab. Click the checkbox next to Idle Timeout, and select a time in the box to the right.

Click OK. The next time you connect, you will be automatically disconnected if you are not using the
Internet after the time you specified. When you want to re-connect, click Connect in the Access Manager
window.

w
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CONNECTING AUTOMATICALLY TO THE BUSINESS INTERNET HIGH SPEED ENTERPRISE SERVICE

If you want to connect automatically (that is, you don’t want to manually start the Access Manager and
click the Connect button each time), follow these instructions.

-
1. Double-click the Access Manager ;ﬂ icon on the desktop. Double-click the Business Internet High

Speed Enterprise icon. Right-click the Access Manager icon at the bottom right of your screen (in the
system tray), then click Application Settings.

2. In the Settings window, click the checkbox

. . Application Setti X
beside Auto-Connect if you want to connect il 2]
automatically. — Settings
Do not check this box if you want to click the I™ iLaunch Access Manager at Windows Staltup.g
Connect button every time you connect. ™ Auto-Connect ;
. ¥ Enable Toolt Advanced | |
3. Check Launch Access Manager at Windows nable Tooltips ‘
Startup if you want the Access Manager to start I” Detailed Log 1
and connect when your computer starts. ™ Use aunique URL for each Profile
4. Uncheck Launch Default Browser after I” Persistent connections
connection if you do not want your browser to I~ Show advertised services in the main folder.
start automatically after the Access Manager ™ Packet Logging
connects. Timeout on connect (Seconds) 30 -
If you want the browser to start automatically,
check this option and type the URL you want the ~Actions - e ———
browser to start with in the box. I™ Play Sound on connection
5. Click OK. |
Yqu may change these settings as often as you I” Launch Default Browser after connection. e
wish. I
oKk | Cancel |
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SWITCHING FROM THE USB CABLE TO THE ETHERNET CABLE

If you are using the Efficient Networks SpeedStream 5200 modem with a USB cable and you wish to use
the Ethernet cable instead, please follow these instructions.

1. Connect the Ethernet cable to the computer, as shown in Installing the Hardware on page 6.

2. Click theicon 5 in the lower left corner of your screen, then click Stop Ethernet USB Adapter.

3. When a message appears saying it is OK to unplug the USB device, unplug the USB cable from your
computer.

4. If you have Windows XP, you’re done. Windows XP will automatically detect which cable you are using.

5. Double-click the Access Manager ﬁ icon on the desktop.
6. Rightclick the Business Internet High Speed Enterprise icon, then click Properties.
7. Inthe Properties window, click the Configuration tab. [Bell Properties x|
8. In the Adapter pull-down menu, click the entry for your Uset Information | TCP Corfiguaton | Servies | About |
Ethernet card.
9. Click OK. ~A C;Z:ftieg:zralion -
Speedstieam Ethemet USE Adapter
~Option

I Require encryption
I~ Log on to the network

|~ Do not modify route metrics when connecting

0K I Cancel | Apply | Help |

10. If you want to remove the USB software, follow the instructions under Removing the Business Internet
High Speed Enterprise software from the computer on page 26.

11. Connect to the Internet as described in Connecting and disconnecting from the Internet on page 18.
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SWITCHING FROM THE ETHERNET CABLE TO THE USB CABLE

If you are using the Efficient Networks SpeedStream 5200 modem with the Ethernet cable and you wish
to use the USB cable instead, please follow these instructions.

1. Download the USB software. In your Web browser, go to http://en.bellnet.ca.

2. Click the Downloads link, and download the USB driver for the SpeedStream 5200 modem. Choose to
download the file to your Desktop.

3. When the download is finished, disconnect from the Internet and unplug the Ethernet cable from your
computer.

4. Double-click the file drv_4.2.2.122 on your Desktop.

5. Click OK in the WinZip Self-Extractor window.
6. Click Unzip in the next window.

T ll files in DRY_4.2.2.122.EXE to the i

s:e::.i:izelpd?nlcief;rness thEUnzip button. = "

Unzip To Folder: Run WirZip |

Y ki Close

[V | Ovenwite Files Without Prompting oo

¥ \When Done Unzipping Bun: setup.exe —

Help

Licensed to Efficient Networks, Inc.

7. Click OK in the final WinZip window.
8. Follow the instructions in the SpeedStream program to install the USB software.

If you have Windows 98 First Edition, you will need your Windows CD to complete the
k installation.

9. When you see the window telling you to connect the modem, connect your Efficient Networks Speed-
Stream 5200 modem as described in Connecting the USB modem on page 10.

SpeedStream

®
SP eedStream Install line filters and connect the modem.

DSL Consult your Quick-Start Guide for details.
Software installation will continue when the
modem is properly connected.

u 1
Updating the Registry
L[] N

Csicient
10. If you do not have Windows XP, you will now be asked to restart your computer. Click Finished to
restart.

/
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11.

12.

13.
14.
15.

16.
17.

If you have Windows XP, you’re done. Windows XP will automatically detect which cable you are using.

(]
Double-click the Access Manager %_‘! icon on the desktop.

Right click the Business Internet High Speed Enterprise icon, then click Properties.

In the Properties window, click the Configuration tab.

In the Adapter pull-down menu, click the entry for your
Ethernet card.

Click OK.

Connect to the Internet as described in Connecting and
disconnecting from the Internet on page 18.
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peiproperies x
User Information | TGP~ Configuration I Services | About |
r— Configuration
Adapter Speedstream Ethemet USB Ad-:] ‘
3Com EtherLink XL 10/100 PCI TX NIC (3C
— Option:

™ Require encryption
I~ Log on to the network
I~ Do not modify route metrics when connecting

0K I Cancel Apply Help




TROUBLESHOOTING

As a subscriber of the Business Internet High Speed Enterprise service, support for the Business Internet High
Speed Enterprise software is always available. Business Internet High Speed Enterprise Services do not
provide support for software other than the Internet Explorer software and the Access Manager that are
included with the Business Internet High Speed Enterprise service. Most problems are easy to solve. Here are
the solutions to some of the most common problems you might encounter.

PROBLEM SUGGESTED ACTION REFERENCE
My Internet If you are using the USB cable, try using the Ethernet cable | Switching from
connection is too slow instead if you have an Ethernet card. the USB cable to
Follow the instructions under Switching from the USB cable to | the Ethernet
the Ethernet cable on page 20. cable on
page 20

Where can | get the USB
software?

1. In your Web browser, go to http://en.bellnet.ca.
2. Click the Downloads link, then download the USB driver
for the Efficient Networks SpeedStream 5200 modem.

3. Follow the instructions under If you are using the USB
cable on page 9.

If you are using
the USB cable
on page 9

How do | remove the
USB software?

Follow the instruction under Removing the Business Internet
High Speed Enterprise software from the computer on
page 26.

Removing the
Business Inter-
net High Speed
Enterprise soft-
ware from the
computer on
page 26

The power light on my
Efficient Networks
SpeedStream 5200
modem is blinking red

The power light will blink red for a few minutes after the
power supply is connected.

Checking your
setup on
page 11

You don’t have enough
free hard drive space to
install the Business
Internet High Speed
Enterprise software

Delete any files you don’t need, but do not delete files if you
don’t know what they are for. Empty the Recycle Bin or
Trash. Try to install the Business Internet High Speed Enter-
prise software again.

Beginning the
Installation on
page 4

Your computer crashed
while using the browser
(computer will not
respond to mouse)

Low disk space: Make sure that you have sufficient free disk
space on your computer. Empty the Recycle Bin or Trash.
You may need to delete some files from your hard drive.
Corrupt cache: To clear the cache with Internet Explorer,
select Internet Options in the Tools menu. Click the Gen-
eral tab, then click the Delete Files button. Click OK, then
click OK again.
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PROBLEM

SUGGESTED ACTION

REFERENCE

You cannot browse the
Internet

Make sure that the cable is connected securely to the Effi-
cient Networks SpeedStream 5200 modem, and that you are
using the right kind of cable.

If you are using the Ethernet cable, turn the Efficient Net-
works SpeedStream 5200 modem off, then back on.

Installing the
Hardware on
page 6

You see a message
about a network error

Exit the browser software, then restart your computer and
try connecting again.

Follow the instructions under Your computer crashed while
using the browser (computer will not respond to mouse) on
page 23.

The browser does not
start when double-
clicked.

Look for the Internet Explorer icon on the taskbar at the bot-
tom of the screen. If you see it, click it once. To prevent this
from happening in the future, click Exit from the browser
File menu when you’re finished rather than simply minimiz-
ing the browser window.

You see a message
about there being more
than three network

adapters in your system.

1. Click #start|, click Settings, then click Control Panel.

2. Double-click the Network icon.

3. Click an unused network adapter in the list, then click
Remove.

4. Repeat the above step until you have only two network
adapters installed.

5. Click OK, and restart your computer if prompted. This
procedure does not remove the software from your
computer; it just prevents the adapter from appearing in
the Network control panel.

You see a message say-
ing “PPP Negotiate Tim-
eout”.

Ensure that your Efficient Networks SpeedStream 5200
modem is connected and turned on.

Installing the
Hardware on
page 6

You see a message say-
ing “Authentication
failed”.

Check your Business Internet High Speed Enterprise Login ID
and password in the Access Manager. Make sure that you
have entered them in lower case.

Connecting and
disconnecting
from the Inter-
net on page 18
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PROBLEM

SUGGESTED ACTION

REFERENCE

You see a message say-
ing “Failed to Bind to
Tap Driver”.

Windows 98/Me:

1. Click #start|, click Settings, then click Control Panel.
2. Double-click the Network icon.

3. Double-click Network TeleSystems P.P.P.o.E Adapter
(NTSP3) in the list.

4. Click the Bindings tab. Make sure that TCP/IP ->
Network TeleSystems P.P.P.o.E Adapter (NTSP3) is
checked.

Windows NT/2000:
*  Please consult your system administrator for assistance.

You see a message
about being unable to
initiate the PPPOE ses-
sion.

Windows 98/Me:

1. In the Access Manager window, double-click the Busi-
ness Internet High Speed Enterprise icon.

2. Right-click the Access Manager icon in the taskbar, and
click Profile Properties.

3. Click the Configuration tab.

4. Make sure that your Ethernet card is selected in the pull-
down menu, then click OK.

Windows NT/2000:
*  Please consult your system administrator for assistance.

You see a message say-
ing that the DHCP cli-
ent could not obtain an
IP address.

Click No.

In order to make the startup process faster, please do the
following:

1. In the Network control panel, click the Protocols tab,
then double-click the TCP/IP protocol.

2. In the Adapter pull-down menu, select the adapter for
your network interface card.

3. Click the IP Address tab, then click Specify an IP
address.

4. Type 192.168.1.1 in the IP address box.
5. Type 255.255.255.0 in the Subnet mask box.
6. Click Apply, then click OK, then click OK again.

Please refer to
your Windows
NT manual for
further infor-
mation about
your network
interface card.

You see a message
about Insufficient
Administrative Privilege
or you cannot start the
Access Manager.

You must log in to Windows NT/2000 as the Administrator in
order to install and use the Access Manager.

Please refer to
your Windows
NT/2000 man-
ual for further
information.
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PROBLEM SUGGESTED ACTION REFERENCE

You see a message Uninstall Access Manager. Disable any anti-virus programs Beginning the
about locating NTSPP- that may be running, then reinstall the Access Manager from | Installation on
PoEx in the registry. the Business Internet High Speed Enterprise CD-ROM. page 4

REMOVING THE BUSINESS INTERNET HIGH SPEED ENTERPRISE SOFTWARE FROM THE COMPUTER

To remove the Business Internet High Speed Enterprise software from your computer, follow these steps:
Removing the USB software

a. Click #start|, click Settings, then click Control Panel.

b. Double-click Add/Remove Programs (Change/Remove with Windows 2000), then click Efficient
Networks SpeedStream DSL.

c. Click the Add/Remove button, then follow the instructions to remove the software.

d. When the computer restarts, unplug the USB cable from the computer.

Internet Explorer

a. Click #start|, click Settings, then click Control Panel.

b. Double-click Add/Remove Programs, then click Microsoft Internet Explorer X and Internet Tools
where X is the version number.

c. Click the Add/Remove button, and follow the instructions.

Access Manager

a. Click #start|, click Programs, click Business Internet High Speed Enterprise, then click Uninstall
Access Manager.

b. Click Yes, and follow the instructions. When you are asked to remove shared files, click Yes to All.

If you have Windows XP

, then click Connect To, then click Show all connections. Delete the connections

you no longer want to use.

OTHER TROUBLESHOOTING RESOURCES

As part of your Business Internet High Speed Enterprise membership, the Help section of the Business
Internet High Speed Enterprise Web site (http://en.bellnet.ca) is a great resource for up-to-date infor-
mation about your account and how to use the Business Internet High Speed Enterprise software. At
any time you are connected to the Internet, click the Help button on any Business Internet High Speed
Enterprise page. You will be linked to the latest news and tips about your Business Internet High Speed
Enterprise software, including information about available upgrades, and billing information.

If you need help using the Internet Explorer software, you can consult its built-in help by clicking the
Help menu, then by clicking Internet Explorer Help.

You can get help for the Access Manager by double-clicking the Access Manager icon, then clicking the
Help button. You do not have to be online to do this.

If you receive an error message on your screen, please write it down before contacting our support ser-
vices. Also, if the error occurred while following the instructions in this guide, note the page and step
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you were at. This information will help the technical support agent’s give you the assistance you need
as quickly as possible.

If you cannot send email to our support services, please have your personal Business Internet account
information in front of you, then call the Business Internet Technical Support Line. The appropriate
number for your region is on the first page of this guide.
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SETTING UP YOUR OPTIONAL BUSINESS INTERNET

DIAL ENTERPRISE HOURS

As part of your Business Internet High Speed Enterprise service your receive 20 hours of

Business Internet Dial Enterprise service FREE each month! When you want to access the
k Business Internet service while away from the office, you can use a dialup connection. Follow
the directions below to configure a dialup connection.

You will need the following items.

* Avregular dial-up modem to connect your computer to a telephone line.
*  Your Business Internet Login ID and password.

Ensure that your regular dial-up modem is installed. If necessary, consult the documentation that
came with your modem.

1. Insert the Business Internet High Speed Enterprise CD into your CD-ROM drive. In Windows Explorer,
right-click the CD-ROM icon, then click Explore.

Double-click the iPass folder, then double-click the iPassConnect icon.
The installation of the Global Roaming software starts. Click Next on the first screen.

4. On the next screen, click Next to install the Global Roaming software in the recommended location. A
progress bar shows the progress of the installation.

5. On the last screen, uncheck the Launch

.
Global Roaming box, then click Finish.

InstallShield Wizard Complete

Setup has finished installing Global Roaming - itinérance
mondiale on your computer.

™ Launch Global Roaming - itinérance mondiale:

< Back Finish I Cancel

6. Double-click the Global Roaming icon m on the desktop.

7. |If this is the first time you have used Global Roaming, you will see a license agreement. Read the
agreement, then click Accept if you agree.
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8. In the Global Roaming window, click your Bl Global Roaming - Rinéiancs s

country in the Country pull-down menu. Options  Bookmarks  Help
. Click your city in the City pull-down menu. Mode |
10. Click the number you want to dial from the list Location
that appears in the Phone Book section of the County [Canada [
window. leince] j
cy[Toone ]

11. If you need to use dialing prefixes or codes to
turn off Call Waiting™ or to access an outside line

Area Code i’ il m-

before dialing, click Dial Properties and type _phmeog,k’
them in the Dial Properties window. Selectal |

0.00 (BCE]

Dial Properties I 416681 1168 Add Bookmark |

Connect | Exit | Help |

12. Click Connect to connect to the Business Internet _

Dial Enterprise service. A User Info window will

appear. Type your Business Internet Dial Enterprise UserInfo |
username and password in the boxes provided. If o emetllogn
your domain is not bellnet.ca, ask your account lISemame DR
administrator for your domain, and type it in the Iiﬂeu, @ Ibe"net‘ca
Domain box. Click OK.

. . Password
If you need more help using the Global Roaming I— P

software, click the Help button in the main window.

0K I Cancel | Help |

13. Click the Options menu, then click Update Phonebook. If you are going to be dialing into the Business
Internet service from other cities, make sure that you update the phonebook before you travel.

14. Double-click the Internet Explorer icon on your desktop. Internet Explorer will start and display your
Business Internet Dial Enterprise home page.

You must always dial with Global Roaming first, then start Internet Explorer.
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DISCONNECTING FROM THE INTERNET

When you are finished exploring the Internet, follow these steps to disconnect from the Business Internet
Dial Enterprise service and exit your software:

1. Quit the Internet applications you are using.

2. Right-click the small Global Roaming icon m in the system tray (the lower right-hand corner of the
screen).
3. Click Disconnect.

CHANGING THE NUMBER YOU DIAL

To change the number you dial (for instance, if you move to another city), follow these steps.

In the Global Roaming window, click your country in the Country pull-down menu.
Click your city in the City pull-down menu.
Click the number you want to dial from the list that appears in the Phone Book section of the window.

If you need to use dialing prefixes or codes to turn off Call Waiting™ or to access an outside line before
dialing, click Dial Properties and type them in the Dial Properties window.

PN

For the latest release of Global Roaming dialer, please visit www.bell.ca/globalroaming

CONNECTING TO YOUR BUSINESS INTERNET HIGH SPEED ENTERPRISE SERVICE

If you have created a dialup connection on a computer that was used for your Business Internet High
Speed Enterprise account, and you now want to use your Business Internet High Speed Enterprise
account again, simply follow the instructions under Connecting and disconnecting from the Internet on
page 18 to connect with the Access Manager.
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TROUBLESHOOTING

As a subscriber of the Business Internet Dial Enterprise service, support is always available to you. Most
problems are easy to solve. Here are the solutions to some of the most common problems you might
encounter while installing and using the software.

PROBLEM

SUGGESTED ACTION

REFERENCE

There is no dial tone
present on your phone
line

If your connection software tells you that your phone line
does not have a dial tone, here are some tips to help you
resolve the problem:

*  Pick up the receiver of your telephone and listen for a
dial tone. If you do not hear a dial tone, another tele-
phone on the same line might be off the hook. Or, there
might be something wrong with your phone line.

¢ Make sure that the modem is turned on, and that the
phone cables are properly connected to the modem
and the phone line. Most modems have two ports on
the back. One should be connected to your telephone
wall jack, and the other may be connected to a standard
telephone. Dial tone errors may result if the two lines
are reversed. External modems will also have a cable
which connects the modem to the back of your com-
puter, and a power cord which reaches from the
modem to the electrical wall outlet. Make sure all cables
and the power cord are firmly plugged in. If the modem
has external lights, at least one of them should be on.

* If you have Call Answer or Message Manager service on
the phone line used by your modem, and you have new
messages waiting, most modems require that you listen
to your messages before trying to connect. Often these
extra phone services provide warnings and notifications
to the customer by sending a slightly different dial tone,
which may not be properly detected by your modem.
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PROBLEM

SUGGESTED ACTION

REFERENCE

You can’t connect to the
Business Internet Dial
Enterprise service

*  Check for a dial tone on your phone line. For more
information, please consult There is no dial tone present
on your phone line above.

*  Your modem may need to be reset for it to initialize
properly. If you have an external modem, you can reset
it simply by turning it off and then on again. If you have
an internal modem, you will need to shut down your
computer and restart it again. Once your modem has
been reset, try connecting again.

*  Verify that any required software for your modem has
been installed properly. If you are not sure about
whether your modem includes special software, look in
the user guide that came with your modem. If you are
not sure whether the software is present on your com-
puter, reinstall the software according to the manufac-
turer’s instructions.

*  Make sure that no other programs are currently using
your modem, such as fax software waiting for an
incoming fax.

*  Check to see that your modem is configured correctly.
See There is no dial tone present on your phone line on
page 31.

The browser is unable to
connect to the network

Clear the browser’s cache:

* Try reloading the page using the Reload or Refresh but-
ton on the browser toolbar.

* If this does not work after a couple of tries, quit the
browser, disconnect from the Business Internet Dial
Enterprise service, and check that your name server
addresses in the TCP/IP Control Panel are correct.

Note: These are generic errors. Do not assume that the Busi-

ness Internet Dial Enterprise service is unavailable.

Your browser does not
start when double-
clicked

This might mean that your browser has already been
started. Give your computer some time (about 20 seconds)
before clicking the browser icon again. Look for your
browser icon on the taskbar at the bottom of the screen. If
you see it, click it once. To prevent this from happening in
the future, click Exit from your browser’s File menu when
you’re finished rather than simply minimizing the window.
It may also be that your browser shortcut has been config-
ured to start minimized. To correct this problem, right-click
the browser shortcut on your desktop and click Properties.
In the Properties window, click the Shortcut tab, and ensure
that Normal window is selected in the Run pop-up menu.

32 Troubleshooting




OTHER TROUBLESHOOTING RESOURCES

REMOVING THE GLOBAL ROAMING SOFTWARE

1. Click Start, click Settings, then click Control Panel. In Windows XP, click Start then click Control
Panel.

2. Double-click Add/Remove Programs, then click Global Roaming.

3. Click the Add/Remove button (in Windows XP click Change/Remove), and follow the instructions to
remove the Global Roaming software.

4. To remove the Global Roaming software, click Global Roaming in the Add/Remove Programs window,
then click Add/Remove, then follow the instructions.

IF NONE OF THE RESOURCES ABOVE HAVE ANSWERED YOUR QUESTION OR PROBLEM

Don’t worry, we’re here to help you. Our support services are staffed by friendly experts who will be happy
to answer your questions.

If you receive an error message on your screen, please write it down before contacting our support
services. Also, if the error occurred while following the instructions in this guide, note the page and step
you were at. This information will help our support services give you the assistance you need as quickly
as possible.

If you cannot send e-mail to Member Services, please have your personal Business Internet Dial Enter-
prise account information in front of you, then call the Business Internet Technical Support Line. The
number is on the first page of this guide.

Please remember that our support services are only equipped to answer questions related to the
Business Internet Dial Enterprise software described in this guide.
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